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1 Introduction 

1.1 Overview 

The EVB9S12XEP100 Evaluation Board has been designed for the evaluation, demonstration 
and debugging of the Freescale MC9S12XEP100 microcontroller.  
The EVB9S12XEP100 can be used as a standalone application, or via its built-in USB-to-BDM 
interface. 

1.2 Package Contents 

The EVB9S12XEP100 package includes the following items: 
 
� The EVB9S12XEP100 evaluation board; 
� A USB cable; 
� An universal, 12 V DC power supply; 
� The SofTec Microsystems “System Software” CD-ROM; 
� The CodeWarrior Development Studio CD-ROM; 
� A Quick Start Guide sheet; 
� This user’s manual. 

1.3 Supported Devices 

The EVB9S12XEP100 Evaluation Board supports the following devices: 

 
� MC9S12XEP100. 

1.4 Recommended Reading 

� Freescale microcontroller-specific datasheets and application notes; 
� EVB9S12XEP100 Schematic. 
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2 Hardware Features 

2.1 Evaluation Board Features 

The EVB9S12XEP100 board features: 
 
1. A “MCU” section containing: 
 

� A MC9S12XEP100 microcontroller (in 144-pin LQFP package, already 
programmed with a demo application); 

� A clock module, and a crystal oscillator, together with jumpers to select the clock 
source; 

� Four header connectors with all of the MCU signals. 
 
2. An Expanded Bus connector (DIN41612) replicating most of the MCU signals. 
3. A power supply section containing a 12 V DC barrel input connector and a 3.3/5.0 V 

voltage selector for powering the board. 
4. A built-in “USB TO BDM INTERFACE” section which allows the host PC to 

communicate with the microcontroller through a standard USB interface. 
5. A BDM connector for interfacing to external in-circuit debuggers. 
6. An “INPUTS” section containing: 
 

� Four push-buttons; 
� One potentiometer; 
� A light sensor; 
� A series of jumpers to connect/disconnect the above controls to/from the 

microcontroller. 
 
7. A reset push-button; 
8. An “OUTPUTS” section containing: 
 

� Two 5x7 dot-matrix displays; 
� Four user LEDs; 
� A series of jumpers to connect/disconnect the above controls to/from the 

microcontroller. 
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Hardware Features 

9. A “CAN” section containing five CAN connectors with five CAN transceivers (high speed 
and fault tolerant), plus a provision for two additional transceivers, together with a series 
of jumpers to select the CAN mode. 

10. A “LIN” section containing six LIN connectors and six LIN transceivers, together with a 
series of jumpers to select the LIN mode. 

11. An “RS-232” section containing two RS-232 connectors together with a series of 
jumpers to set the RS-232 mode. 

12. A “SERIAL SETTINGS” section containing a series of jumpers to select which MCU pins 
are used for the various serial functions. 

13. An “I2C” and “SCI” areas replicating the MCU’s  I2C0, I2C1, SCI6 and SCI7 signals. 
14. A prototype area. 
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3 Software Setup 

3.1 Overview 

i 
 

Note: before connecting the Evaluation Board to the PC, it is 
recommended that you install all of the required software first (see 
below), so that the appropriate USB driver will be automatically found by 
Windows when you connect the Evaluation Board. 

 
The Evaluation Board requires that both CodeWarrior Development Studio and SofTec 
Microsystems Additional Components be installed in the host PC. 
 

i 
 

Note: CodeWarrior Development Studio must be installed first. 

3.2 Host System Requirements 

The Evaluation Board is controlled by CodeWarrior Development Studio. The following 
hardware and software are required to run the CodeWarrior user interface together with the 
Evaluation Board: 
 

� A 200-MHz (or higher) PC compatible system running Windows 98, Windows 2000 or 
Windows XP; 

� 128 MB of available system RAM plus 1 GB of available hard disk space; 
� A USB port; 
� CD-ROM drive for installation. 

3.3 Installing CodeWarrior Development Studio 

To install the CodeWarrior Development Studio, insert the CodeWarrior CD-ROM into your 
computer’s CD-ROM drive. A startup window will automatically appear. Follow the on-screen 
instructions. 
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3.4 Installing SofTec Microsystems Additional 
Components 

The SofTec Microsystems Additional Components install all of the other required components 
to your hard drive. These components include: 

 
� The Evaluation Board’s USB driver; 
� The software plug-in for CodeWarrior; 
� Examples for CodeWarrior; 
� Evaluation Board’s user’s manual; 
� Evaluation Board’s schematic; 
� Additional documentation. 

 
To install the SofTec Microsystems Additional Components, insert the SofTec Microsystems 
“System Software” CD-ROM into your computer’s CD-ROM drive. A startup window will 
automatically appear. Choose “Install Instrument Software” from the main menu. A list of 
available software will appear. Click on the “Additional Components” option. Follow the on-
screen instructions. 
 

i 
 

Note: to install the Additional Components on Windows 2000 or Windows 
XP, you must log in as Administrator. 
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4 Hardware Setup 

4.1 First Connection 

The Evaluation Board is connected to a host PC through a USB port. Connection steps are 
listed below in the recommended flow order: 
 
1. Install all the required system software as described in the previous section. 
2. Power the board through the barrel connector (12 V DC). The “POWER” LED will turn 

on. 
3. Insert one end of the USB cable into a free USB port of the PC. 
4. Insert the other end of the USB cable into the USB connector on the Evaluation Board. 
5. The first time the Evaluation Board is connected to the PC, Windows recognizes the 

instrument and starts the “Found New Hardware Wizard” procedure, asking you to 
specify the driver to use for the instrument. On Windows XP (SP2) the following dialog 
box will appear. 

 

 
 

Select the “No, not this time” option and click the “Next >” button. 
6. The following dialog box will appear. 
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Click the “Next >” button. 
7. Depending on your Windows settings, the following warning may appear. 
 

 
 

i 
 

Note: this warning is related to the fact that the USB driver used by 
the Evaluation Board is not digitally signed by Microsoft, and 
Windows considers it to be potentially malfunctioning or dangerous 
for the system. However, you can safely ignore the warning, since 
every kind of compatibility/security test has been carried out by 
SofTec Microsystems. 

 
Click the “Continue Anyway” button. 

8. Windows will install the driver files to your system. At the end of the installation, the 
following dialog box will appear. 
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Click the “Finish” button to exit from the “Found New Hardware Wizard” procedure. 
9. The Evaluation Board’s USB driver is now installed on your system. 
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5 Operating Modes 

5.1 Overview 

The Evaluation Board can work in two modes: “standalone” mode and “host” mode. 

5.2 Standalone Mode 

In standalone mode, no PC connection is required. The microcontroller is factory programmed 
with a sample application. 
To run the built-in example: 
 
1. Verify that all jumpers are in their default position. See the “Jumpers and Connectors 

Settings” chapter. 
2. Power the board. The power connector accepts 12 V DC wall plug-in power supply with 

a 2.1 mm pin and sleeve plug with positive in the center and sleeve as ground. The 
green “POWER” LED on the board should turn on. 

3. Press the “PB4” push-button. The output of the light sensor will be displayed on the two 
dot-matrix displays, in a graphical way. The light sensor is placed on the left of the “PB7” 
push-button. Cover the sensor with a finger and see the effect on the displays. 

4. Press the “PB5” push-button. The output of the light sensor will be displayed on the two 
dot-matrix displays, in a numerical (hexadecimal) way. 

5. Press the “PB6” push-button. The value of the “PAD10” potentiometer will be displayed 
on the two dot-matrix displays, in a graphical way. 

6. Press the “PB7” push-button. The value of the “PAD10” potentiometer will be displayed 
on the two dot-matrix displays, in a numerical (hexadecimal) way. 

5.3 Host Mode 

In host mode the program execution is controlled by the host PC through the “USB” connector. 
You can use the PC to debug the application by, for example, executing the program step by 
step and watching how the microcontroller registers vary, using the provided CodeWarrior 
Development Studio. 
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Operating Modes 

i 
 

Note: all MCUs in the S12X family contain a single-wire background 
debug interface which supports in-circuit programming of on-chip non-
volatile memory. This system does not interfere with normal application 
resources. It does not use any user memory or locations in the memory 
map. The Background Debug Module (BDM) uses a single-wire 
communication interface (via the BKGD line) to allow non-intrusive access 
to target system memory and registers. 

 
To work in host mode (using the built-in USB to BDM interface): 
 
� Make sure that the board is powered on; 
� Make sure that the “RESET ENA” and “BKGD ENA” jumpers in the “USB TO BDM 

INTERFACE” section are inserted; 
� Connect the host PC to the board through the provided USB cable. 
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6 Application Tutorial 

6.1 Overview 

This section will provide a step-by-step guide on how to launch your first project and get 
started with the CodeWarrior user interface (working in Host Mode). 

6.2 Step-by-Step Tutorial 

The sample application is the same as the one described in the “Standalone Mode” section 
above. 
 
1. Set up the board so that it works in host mode (see “Host Mode” above). 
2. Ensure that the Evaluation Board is connected to the PC (via the USB cable) and that 

the board is powered on. 
3. Start CodeWarrior by selecting it in the Windows Start menu. 
4. From the CodeWarrior main menu, choose “File > Open” and choose the “\Program 

Files\Freescale\CW for HC12 V4.5\(CodeWarrior_Examples)\HCS12X\Evaluation 
Board Examples\EVB9S12XEP100\C\Demo\Demo.mcp”. 

5. Click “Open”. The Project Window will open. 
6. The code of this example is contained in the “main.c” file. Double click on it to open. 
7. From the main menu, choose “Project > Debug”. This will compile the source code, 

generate an executable file and download it to the demo board. 
8. A new debugger environment will open. From the main menu, choose “Run > 

Start/Continue”. The program will be executed in real-time. 
9. From the main menu, choose “Run > Halt”. The program execution will stop. The next 

instruction to be executed is highlighted in the Source window. 
10. From the main menu, choose “Run > Single Step”. The instruction highlighted in the 

Source window will be executed, and the program execution will be stopped immediately 
after. 

11. From the main menu, choose “Run > Start/Continue”. The application will restart from 
where it was previously stopped. 

  
Congratulations! You have successfully completed this tutorial! You can continue to 
experiment with the CodeWarrior user interface and discover by yourself its potentialities. For 
an in-depth guide of all of the user interface features, select “Help > CodeWarrior Help” from 
CodeWarrior Development Studio’s main menu.
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7 Jumpers and Connectors Settings 

7.1 Jumpers 

Name Reference Description/Pinout 

J106 
 

 MODA=1 
 
Installed: MODA line pulled to VDD 
Not Installed: MODA line tied to ground by internal pull 

down (default) 

J107 
 

 MODB=1 
 
Installed: MODB line pulled to VDD 
Not Installed: MODB line tied to ground by internal pull 

down (default) 

J108 
 

 

1

2

3

 

 

  

MODC SELECTION 
 
1-2 (“1”): MODC pulled to VDD via a 4.7 KOhm 

resistor (default) 
2-3 (“0”): MODC line pulled to ground via a 4.7 

KOhm resistor 

J109 
 

 

1

2

3

 

 

  

VRH SELECTION 
 
1-2 (“VDDA”): VRH tied to VDDA (default) 
2-3 (“USER”): VRH connected to the J103 connector  

J110 
 

 

1

2

3

 

 

  

VRL SELECTION 
 
1-2 (“GND”): VRL tied to ground (default) 
2-3 (“USER”): VRL connected to the J104 connector 

J111 
 

 

1

2

3

 

 

  

OSC SELECTION 
 
1-2 (“CRYSTAL”): Crystal oscillator selected (default) 
2-3 (“CLOCK”): Clock oscillator selected  

J112 
 

 XCLKS#=0 
 
Installed: XCLKS# pin pushed to ground. Full-swing 

Pierce oscillator or external clock source 
selected. 

Not Installed:  XCLKS# pulled to VDD. Loop controlled 
Pierce oscillator selected. (default) 
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Name Reference Description/Pinout 

J102 
 

1

2

3

 

 

  

VDD SELECTION 
 
1-2 (“3V3”): Board powered by 3.3 V 
2-3 (“5V”): Board powered by 5.0 V (default) 

J204 
 

   PUSH-BUTTON “PB4” ENABLE 
 
Installed: The “PB4” push-button is connected to 

the microcontroller’s PB4 line (default) 
Not Installed: The “PB4” push-button is not connected to 

the microcontroller’s PB4 line 

J205 
 

   PUSH-BUTTON “PB5” ENABLE 
 
Installed: The “PB5” push-button is connected to 

the microcontroller’s PB5 line (default) 
Not Installed: The “PB5” push-button is not connected to 

the microcontroller’s PB5 line 

J206 
 

   PUSH-BUTTON “PB6” ENABLE 
 
Installed: The “PB6” push-button is connected to 

the microcontroller’s PB6 line (default) 
Not Installed: The “PB6” push-button is not connected to 

the microcontroller’s PB6 line 

J207 
 

   PUSH-BUTTON “PB7” ENABLE 
 
Installed: The “PB7” push-button is connected to 

the microcontroller’s PB7 line (default) 
Not Installed: The “PB7” push-button is not connected to 

the microcontroller’s PB7 line 

J208 
 

   POTENTIOMETER ENABLE 
 
Installed: The “PAD10” potentiomenter is 

connected to the microcontroller’s 
PAD10 line (default) 

Not Installed: The “PAD10” potentiomenter is not 
connected to the microcontroller’s PAD10 
line 

J209 
 

 PHOTO RESISTOR ENABLE 
 
Installed: The photoresistor network is connected 

to the microcontroller’s PAD11 analog 
input (default) 

Not Installed: The photoresistor network is not connected 
to the microcontroller 
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Name Reference Description/Pinout 

J210 
 

1

   

DISPLAY ROW ENABLE 
 
Installed: The displays’ common rows are 

connected to the PA[6..0] ports of the 
microcontroller (default) 

Not Installed: The displays’ common rows are not 
connected to the microcontroller. 

J211 
 

1  

DISPLAY COL ENABLE (DISP201) 
 
Installed: The DISP201 display’s columns are 

connected to the PC[4..0] ports of the 
microcontroller (default) 

Not Installed: The DISP201 display’s columns are not 
connected to the  microcontroller. 

J212 
 

1  

DISPLAY COL ENABLE (DISP202) 
 
Installed: The DISP202 display’s columns are 

connected to the PD[4..0] ports of the 
microcontroller (default) 

Not Installed: The DISP202 display’s columns are not 
connected to the  microcontroller. 

J213 
 

1  

 

LED ENABLE 
 
Installed: The LEDs are connected to PB[3..0] 

ports of the microcontroller (default) 
Not Installed: The LEDs are not connected to 

microcontroller. 

J303 
 

1 2

4

6

3

5  

SCI0 DTE/DCE SELECTION 
 
1-3, 2-4 (“DCE”): The RS-232 channel 0 is configured as 

DCE (default) 
3-5, 4-6 (“DTE”): The RS-232 channel 0 is configured as 

DTE 

J304 
 

1 2

4

6

3

5  

SCI1 DTE/DCE SELECTION 
 
1-3, 2-4 (“DCE”): The RS-232 channel 1 is configured as 

DCE (default) 
3-5, 4-6 (“DTE”): The RS-232 channel 1 is configured as 

DTE 

J305 
 

 LIN MASTER NODE0 ENABLE 
 
Installed: Master node (default) 
Not Installed: Slave node 
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Name Reference Description/Pinout 

J307 
 

 LIN MASTER NODE1 ENABLE 
 
Installed: Master node (default) 
Not Installed: Slave node 

J309 
 

 LINE MASTER NODE2 ENABLE 
 
Installed: Master node (default) 
Not Installed: Slave node 

J311 
 

 LIN MASTER NODE3 ENABLE 
 
Installed: Master node (default) 
Not Installed: Slave node 

J313 
 

 LIN MASTER NODE4 ENABLE 
 
Installed: Master node (default) 
Not Installed: Slave node 

J315 
 

 LIN MASTER NODE5 ENABLE 
 
Installed: Master node (default) 
Not Installed: Slave node 

J317 
 

 

1

2

3

 

 

  

LIN TRANSCEIVER SUPPLY SELECTION 
 
1-2 (“12V”):  LIN transceivers are supplied by the 

board’s internal 12 V DC voltage 
(default) 

2-3 (“LIN NETW.”): LIN transceivers supplied by the LIN bus’s 
VBAT line 

J318 
 

 LIN SUPPLY ENABLE 
 
Installed: LIN bus is powered by the board’s 

internal 12 V DC voltage (default) 
Not Installed: LIN bus is self-powered 

J319 
 

 LIN2 RX ENABLE 
 
Installed: PJ0/RXD2 microcontroller line 

connected to LIN2 transceiver (default) 
Not Installed: PJ0/RXD2 microcontroller line floating 

J320 
 

 LIN2 TX ENABLE 
 
Installed: PJ1/TXD2 microcontroller line 

connected to LIN2 transceiver (default) 
Not Installed: PJ1/TXD2 microcontroller line floating 
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Name Reference Description/Pinout 

J321 
 

 LIN4 RX ENABLE 
 
Installed: PH4/RXD4 microcontroller line 

connected to LIN4 transceiver (default) 
Not Installed: PH4/RXD4 microcontroller line floating 

J322 
 

 LIN4 TX ENABLE 
 
Installed: PH5/TXD4 microcontroller line 

connected to LIN4 transceiver (default) 
Not Installed: PH5/TXD4 microcontroller line floating 

J323 
 

 LIN5 RX ENABLE 
 
Installed: PH6/RXD5 microcontroller line 

connected to LIN5 transceiver (default) 
Not Installed: PH6/RXD5 microcontroller line floating 

J324 
 

 LIN5 TX ENABLE 
 
Installed: PH7/TXD5 microcontroller line 

connected to LIN5 transceiver (default) 
Not Installed: PH7/TXD5 microcontroller line floating 

J330 
 

1 2

4

6

3

5  

RS-232_0 SCI0/6 SELECTION 
 
1-3, 2-4 (“SCI6”): The RS-232 channel 0 transceiver is 

connected to the microcontroller’s SCI6 
peripheral (default) 

3-5, 4-6 (“SCI0”): The RS-232 channel 0 transceiver is 
connected to the pin 1 and pin2 of the J331 
jumper 

J331 
 

1 2

4

6

3

5  

RS-232_0/LIN0 SELECTION 
 
1-3, 2-4 (“RS-232”): The microcontroller’s SCI0 peripheral is 

connected to the pin 5 and pin 6 of the J330 
jumper 

3-5, 4-6 (“LIN”): The microcontroller’s SCI0 peripheral is 
connected to LIN0 transceiver (default) 

J332 
 

1 2

4

6

3

5  

RS-232_1 SCI1/7 SELECTION 
 
1-3, 2-4 (“SCI7”): The RS-232 channel 1 transceiver is 

connected to the microcontroller’s SCI7 
peripheral (default) 

3-5, 4-6 (“SCI1”): The RS-232 channel 1 transceiver is 
connected to the pin 1 and pin2 of the J333 
jumper 
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Name Reference Description/Pinout 

J333 
 

1 2

4

6

3

5  

RS-232_1/LIN1 SELECTION 
 
1-3, 2-4 (“RS-232”): The microcontroller’s SCI1 peripheral is 

connected to the pin 5 and pin 6 of the J332 
jumper 

3-5, 4-6 (“LIN”): The microcontroller’s SCI1 peripheral is 
connected to LIN1 transceiver (default) 

J334 
 

1 2

4

6

3

5  

CAN3/LIN3 SELECTION 
 
1-3, 2-4 (“LIN”): The microcontroller’s SCI3 peripheral is 

connected to the LIN3 transceiver 
3-5, 4-6 (“CAN”): The microcontroller’s CAN3 peripheral is 

connected to the CAN3 transceiver 
(default) 

J401 
 

 

1

2

3

 

 

  

CANH0 SELECTION 
 
1-2 (“U401”): CAN0 connector’s CANH signal 

provided by U401 transceiver (default) 
2-3 (“U406”): CAN0 connector’s CANH signal provided 

by U406 transceiver 

J402 
 

 

1

2

3

 

 

  

CANL0 SELECTION 
 
1-2 (“U401”): CAN0 connector’s CANL signal provided 

by U401 transceiver (default) 
2-3 (“U406”): CAN0 connector’s CANL signal provided by 

U406 transceiver 

J404 
 

 

1

2

3

 

 

  

CANH1 SELECTION 
 
1-2 (“U402”): CAN1 connector’s CANH signal 

provided by U402 transceiver (default) 
2-3 (“U407”): CAN1 connector’s CANH signal provided 

by U407 transceiver 

J405 
 

 

1

2

3

 

 

  

CANL1 SELECTION 
 
1-2 (“U402”): CAN1 connector’s CANL signal provided 

by U402 transceiver (default) 
2-3 (“U407”): CAN1 connector’s CANL signal provided by 

U407 transceiver 

J407 
 

 CAN2 VCC ENABLE 
 
Installed: Powers the CAN2 transceiver with a 5 V 

voltage (default) 
Not Installed: CAN2 transceiver not powered 
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Name Reference Description/Pinout 

J409 
 

 CAN4 VCC ENABLE 
 
Installed: Powers the CAN4 transceiver with a 5 V 

voltage (default) 
Not Installed: CAN4 transceiver not powered 

J412 
 

 CAN3 RESET ENABLE 
 
Installed: Microcontroller’s RESET# line connected to 

the CAN3 transceiver’s RESET# line 
Not Installed: CAN3 transceiver RESET# line floating 

(default) 

J413 
 

 CAN3 INTERRUPT ENABLE 
 
Installed: Microcontroller’s PE1 line connected to the 

CAN3 transceiver’s INTB line 
Not Installed: CAN3 transceiver INTB line floating 

(default) 

J414 
 

 CAN0 RX ENABLE 
 
Installed: Microcontroller’s PM0/RXCAN0 line 

connected to CAN0 transceiver (default) 
Not Installed: Microcontroller’s PM0/RXCAN0 line floating 

J415 
 

 CAN0 TX ENABLE 
 
Installed: Microcontroller’s PM1/TXCAN0 line 

connected to CAN0 transceiver (default) 
Not Installed: Microcontroller’s PM1/TXCAN0 line floating 

J416 
 

 CAN1 RX ENABLE 
 
Installed: Microcontroller’s PM2/RXCAN1 line 

connected to CAN1 transceiver (default) 
Not Installed: Microcontroller’s PM2/RXCAN1 line floating 

J417 
 

 CAN1 TX ENABLE 
 
Installed: Microcontroller’s PM3/TXCAN1 line 

connected to CAN1 transceiver (default) 
Not Installed: Microcontroller’s PM3/TXCAN1 line floating 

J418 
 

 CAN2 RX ENABLE 
 
Installed: Microcontroller’s PM4/RXCAN2 line 

connected to CAN2 transceiver (default) 
Not Installed: Microcontroller’s PM4/RXCAN2 line floating 
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Name Reference Description/Pinout 

J419 
 

 CAN2 TX ENABLE 
 
Installed: Microcontroller’s PM5/TXCAN2 line 

connected to CAN2 transceiver (default) 
Not Installed: Microcontroller’s PM5/TXCAN2 line floating 

J420 
 

 CAN4 RX ENABLE 
 
Installed: Microcontroller’s PJ6/RXCAN4 line 

connected to CAN4 transceiver (default) 
Not Installed: Microcontroller’s PJ6/RXCAN4 line floating 

J421 
 

 CAN4 TX ENABLE 
 
Installed: Microcontroller’s PJ7/TXCAN4 line 

connected to CAN4 transceiver (default) 
Not Installed: Microcontroller’s PJ7/TXCAN4 line floating 

J502 
 

 RESET ENABLE (USB TO BDM) 
 
Installed: Microcontroller’s RESET# line 

connected to the “USB TO BDM 
INTERFACE” (default) 

Not Installed: Microcontroller’s RESET# line not 
connected to the “USB TO BDM 
INTERFACE” 

J503 
 

 BKGD ENABLE (USB TO BDM) 
 
Installed: Microcontroller’s BKGD line connected 

to the “USB TO BDM INTERFACE” 
(default) 

Not Installed: Microcontroller’s BKGD line not connected 
to the “USB TO BDM INTERFACE” 
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7.2  Connectors 

Name Reference Description/Pinout 

J101, 
J102, 
J103, 
J104 

 MCU I/O Connectors 
 
See schematic for pin explanation 

J105 
 

1 2

3

5

4 

6 

 

 

BDM Connector 
 
1. BKGD 
2. GND 
3. N.C. 
4. RESET 
5. N.C. 
6. VDD 

J113, 
J203, 
J325, 
J422, 
J504 

 

Test Points 
 

J201 
 

2 1 

 

12 V DC Power Supply Input Connector (2.1 mm Barrel) 
 
1. 12 V DC 
2. GND 

J301 

 

69 
5 1  

RS-232_0 Connector 
 
1. N.C. 
2. TX or RX (see J303 jumper) 
3. RX or TX (see J303 jumper) 
4. N.C. 
5. GND 
6. N.C. 
7. N.C. 
8. N.C. 
9. N.C. 

J302 

 

69 
5 1  

RS-232_1 Connector 
 
1. N.C. 
2. TX or RX (see J304 jumper) 
3. RX or TX (see J304 jumper) 
4. N.C. 
5. GND 
6. N.C. 
7. N.C. 
8. N.C. 
9. N.C. 
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Jumpers and Connectors Settings 

Name Reference Description/Pinout 

J306 
 

 

1

2

3

 

 

  

LIN0 Connector 
 
1. VBAT – LIN Bus Power Supply 
2. LIN – LIN Signal 
3. GND 

J308 

1  

LIN1 Connector 
 
1. GND 
2. GND 
3. VBAT – LIN Bus Power Supply 
4. LIN – LIN Signal 

J310 
 

 

1

2

3

 

 

  

LIN2 Connector 
 
1. VBAT – LIN Bus Power Supply 
2. LIN – LIN Signal 
3. GND 

J312 

1  

LIN3 Connector 
 
1. GND 
2. GND 
3. VBAT – LIN Bus Power Supply 
4. LIN – LIN Signal 

J314 
 

 

1

2

3

 

 

  

LIN4 Connector 
 
1. VBAT – LIN Bus Power Supply 
2. LIN – LIN Signal 
3. GND 

J316 

1  

LIN5 Connector 
 
1. GND 
2. GND 
3. VBAT – LIN Bus Power Supply 
4. LIN – LIN Signal 

J326 
 

 

1

2

 

  

SCI6 Connector 
 
1. RX 
2. TX 

J327 
 

 

1

2

 

  

SCI7 Connector 
 
1. RX 
2. TX 
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Name Reference Description/Pinout 

J328 
 

 

1

2

 

  

I2C0 Connector 
 
1. SDA 
2. SCL 

J329 
 

 

1

2

 

  

I2C1 Connector 
 
1. SDA 
2. SCL 

J403 1

 

CAN0 Connector 
 
1. CANH 
2. CANL 
3. GND 
4. N.C. 

J406 1

 

CAN1 Connector 
 
1. CANH 
2. CANL 
3. GND 
4. N.C. 

J408 
 

1 2 3  
CAN2 Connector 
 
1. CANH 
2. GND 
3. CANL 

J410 1

 

CAN4 Connector 
 
1. CANH 
2. CANL 
3. GND 
4. N.C. 

J411 
 

1 2 3  
CAN3 Connector 
 
1. CANH 
2. GND 
3. CANL 

J423 
 

1a
1b
1c

 

 

Expanded Bus Connector 
 
DIN41612 female type R (see schematic for pin explanation) 
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Jumpers and Connectors Settings 

Name Reference Description/Pinout 

J501 

 

USB Connector 
 
1. 5 V DC USB Bus Power Supply Line 
2. USB D- 
3. USB D+ 
4. GND 
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8 Troubleshooting 

8.1 USB Driver Problems 

If you connected the Evaluation Board to the PC before installing the SofTec Microsystems 
Additional Components, the Evaluation Board’s USB driver may not have been correctly 
installed on your system. Unplugging and replugging the USB cable is of no use, since 
Windows has marked the device as “disabled”. As a consequence, the PC cannot 
communicate with the Evaluation Board. 
To restore the USB driver (provided the SofTec Microsystems Additional Components have 
been installed), perform the following steps under Windows XP: 
 
1. Connect the Evaluation Board to the PC. 
2. Open the Control Panel (Start > Settings > Control Panel). 
3. Open  the “System” options. 
4. Select the “Hardware” tab. 
5. Click the “Device Manager” button. 
6. The “uDART In-Circuit Debugger” device will be shown with an exclamation mark next 

to it. Double click on this device. 
7. In the “General” tab, click the “Reinstall Driver” button. Follow the on-screen 

instructions. 

8.2 Communication Problems between the PC and the 
Evaluation Board 

1. Make sure that the “BKGD ENA” and “RESET ENA” jumpers in the “USB TO BDM 
INTERFACE” section are inserted. 

2. Make sure that the board is powered (verify that the “POWER” LED is turned on). 
3. Make sure that a correct clock source is selected.
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